
of management so hinder the 

efficient operations of the 

practice that continued reve-

nue growth becomes virtually 

impossible without major 

changes. 

Similar in scope to the law of 

diminishing returns or the 

law of increasing opportunity 

costs (originating with early 

18th and 19th century econo-

mists such as Thomas Mal-

thus and David Ricardo), 

increases in gross revenue 

could be outpaced by expo-

nential increases in the cost 

of doing business.  

(Continued on Page 4) 

One of the great challenges of 

management is adjusting to 

the growth of a firm. The 

adjustment is not confined to 

the owner/manager. Adjust-

ments must be made by all 

members of the firm. Clearly, 

though, the first and most 

fundamental step is for the 

owner/manager of the firm to 

recognize that as the firm 

grows, he/she must change 

the way in which manage-

ment of the firm is handled. 

For most practitioners that 

began as a one-person shop, 

this is a difficult task. When 

operating a one-person shop, 

the owner does it all, from 

clerical to analytical. When 

the first employee is added, 

there is still little need for 

formal management tech-

niques, as there may be time 

to discuss most everything. 

But, as more and more em-

ployees are added, there is an 

inefficiency of scale that sets 

in, interfering with work pro-

ductivity, increasing time 

demands on the owner/

manager and potentially lim-

iting profitability. Often re-

ferred to as the “revenue 

ceiling”, it is the point in 

growth where the limitations 
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ACT! for Financial Professionals (AFFP) 

You probably have 

heard of ACT! the con-

tact management sys-

tem from Sage Soft-

ware. You may have 

heard of ACT4Advisors, 

a templated version of 

ACT! designed for finan-

cial advisors. But, did 

you know that there is 

another version, called 

ACT! for Financial Pro-

fessionals? This ver-

sion, produced by SLM 

(SLMBIZ.com) was 

originally developed by 

Vertical Falls software 

and has been licensed 

to over 17,000 advisors, 

mainly through major 

Broker/Dealer relation-

ships such as Smith 

Barney. Other firms 

such as Morgan 

Stanley, Wachovia and 

others are also users. 

So, what makes this 

version different from 

the others, you ask? 

Well, it turns out, there 

are huge differences, 

from customization to 

layout to the 

20 integrated tools that 

make your life easier 

and more efficient. 

Rather than a template, 

this company custom-

izes ACT for your firm. 
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Some advisors have developed nests of clients in remote locations from their main office. This 

may have been by design or it could possibly be as a result of clients’ referrals, clients moving to 

another location or other client acquisition techniques. Though, having nests of clients can pro-

vide a firm with expanded revenue opportunities, it also poses significant technological chal-

lenges. 

One of the challenges is reliable access to files and information while “on the road.” If you are 

the owner of a so-called ‘Smartphone’ such as a Treo, Blackberry or similar, then you are famil-

iar with synchronization software. Most of these devices either use Microsoft’s Activesync soft-

ware, Palm’s Hotsync software or something similar. If you are familiar with these, you may also 

be familiar (or frustrated by) their almost universal lack of flexibility. To synchronize files and/or 

information between a desktop machine and a laptop could involve a two-step process: sync’ing 

the Smartphone first and then resync’ing with the laptop. Even then, not everything gets updated. 

Only certain files, usually associated with the software and/or functionality of the Smartphone, 

get synchronized. If Microsoft Outlook is the email software of choice, generally the schedule, 

contacts and notes are transferred, but not necessarily the emails. 

Other files, such as financial plan output documents, hypotheticals, investment reports, etc. do 

not generally get included in the updates. Thus, some advisors have chosen to use a remote ac-

cess software solution such as GoToMyPc.com. Despite the reliability of the platform, it is often 

slower and more laborious to answer emails through the same web connection as your remote 

access. (Bandwidth is typically cut in half). One workaround is to use a version of your email 

program on your laptop to read emails, while creating settings that preserve a copy of the email 

on the email host platform. But, even this can be inefficient as it could create a huge backlog of 

emails to wade through once you return to your office desktop. 

So, the question remains as to what other choices might be available. On November 8, 2007, 

Siber Systems, Inc. announced the release of GoodSync Version 6, the latest version of its award

-winning data backup and synchronization product.  Despite a simplicity and power that has 

earned it top praise from Computer Shopper, Network World and various other computer maga-

zines and software Web sites, Version 6 has become even faster and easier to use, thanks to a 

slick new graphic interface and an improved synchronization algorithm proven capable of sync-

ing a million files at once. 

GoodSync allows users to synchronize data between any two PCs or storage devices, in any di-

rection.  Backups and synchronizations can be accomplished via USB cable, over a home or 

workplace network, or even the Internet.  The highly advanced product automatically detects the 

latest file changes and deletions regardless of where the changes/deletions exist, then moves 

them to all other devices involved in the sync—a perfect tool for updating and transferring mu-

sic, videos, work files, photos or other important information. 

Another Efficient Tool for the Remote Advisor 
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GoodSync Version 6 adds a number of new features that 

make it easy enough, yet robust enough for both home and 

business use.  User improvements in Version 6 include: 

 

• A new tree-based interface that allows users to more 
easily view file changes; 

• An improved file status display that shows files 
matched, files unmatched and sync direction; 

• Advanced automatic settings that allow complete set-it-

and-forget-it flexibility; 

• Easy job setup with a tabbed display that facilitates 
switching between multiple jobs; 

• Improved first time help messages offered through pop
-up balloons; 

• An online, step-by-step tutorial; and 

Now available in 12 languages. 
 

 

To simplify synchronization 

tasks, syncs can be set to run 

automatically on logon or 

logoff using an AutoSync 

setting; what’s more, 

GoodSync can be set up to 

automatically save a copy of a 

file that GoodSync is about to 

replace when syncing, ensur-

ing that the last two versions 

of any file are maintained for 

recovery if needed. For those 

firms concerned with Sar-

banes-Oxley compliance with 

offsite storage and retrieval 

solutions that are cost-

effective and efficient, 

GoodSync might just be the 

right solution. 

 

The good news is that this 
innovative data backup and 
synchronization utility is 

FREE for personal use; a pro-
fessional version of the prod-
uct can be purchased for 
$19.95 (USD), with Enter-
prise and OEM pricing avail-
able.  GoodSync Version 6 is 
now available for download 
or purchase at 

www.goodsync.com. 

The user interface has just 

two main options, Analyze 

and Sync, making the soft-

ware easy for beginners, yet 

very robust for advanced us-

ers and tasks.  There are also 

automatic settings, help bal-

loons, an online tutorial, the 

ability to sync a million files 

at once, plus a free trial offer. 

Larger firms have discovered 

the enterprise-class backup 

performance of 

GoodSync.  Version 6 offers 

a host of features that add to 

GoodSync’s appeal, including 

automatic settings that enable 

GoodSync to periodically 

perform backups throughout 

the business day without af-

fecting worker productivity. 
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One firm recently reported that they were adding new employees at the rate of two a year to keep 

pace with increased workload, yet their net revenue number continued to remain the same as 

before (or slightly decline). Bringing on more clients, increasing asset management (AUM) fees 

and creating new recurring revenue sources also did not seem to help the bottom line. The dis-

couraged partners were seriously considering breaking the firm apart and downsizing. 

 

When a practice efficiency analysis was accomplished, several things came to light (four of 

which are mentioned here). First, the firm was operating as a modified silo firm. This is where 

each of the five partners essentially ran their own operation. But, an attempt had been made to 

integrate staff to some degree. This created a boondoggle for employees who were asked to adapt 

on a daily basis to five different styles of doing business. 

 

Second, most reports (quarterly investment reports, for instance) were taking each of four staff 

assistants around 8 hours (per report per staff member) to prepare. This is because the source 

data was coming from multiple locations (different software, websites, etc.) and had to be manu-

ally integrated into a single document. Often the resulting document had mismatched fonts, pagi-

nation, formatting and styles. 

 

Third, Management style was somewhat myopic in structure. There was an office manager 

charged with running the office, but had little authority to actually manage the employees. If he 

was given the task of assigning work, many times, one or another partner would go around the 

manager to assign additional unrelated work to the same employee, requesting priority. 

 

Fourth, there was no formal workflow process and follow-up procedure in place. With a lack of 

workflow and/or task completion standards (time and quality), there was no structural methodol-

ogy for evaluating employee and/or manager performance. With close to 30 employees, this firm 

was attempting to run itself using the same techniques as a much smaller firm and it simply was 

not working. 

So, what can a firm do to turn a situation like this around? One method is to start at the source of 

the problem, the management structure and systems (or lack thereof). A silo firm that attempts to 

integrate staff is asking for problems. Either you are a silo or you are not. First step is determin-

ing the structure of the firm and building it. Most silo firms come to realize that there are inher-

ent inefficiencies due to the differences in the way that the various partners conduct business. In 

some cases this may be necessary, owing to the unique nature of that part of the firm’s business 

(i.e. a specialization in divorce, medical practices, etc.). With such specialization, it may be nec-

essary to build systems that are unique to that type of client.  

Operational Leadership: Continued from Page One 
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dedicated to those specialties may not be easily able to integrate with other partners in the firm 

and should not be attempted. For that specialization partner, it may be necessary to split off the 

specific work that is related to the specialization and dedicate an employee(s) to that specific set 

of tasks. For more general tasks, clerical, contact management, etc., it may still be possible to 

integrate other staff, though extreme care must be taken to standardize workflow for this type of 

staff member.  

In developing workflow management systems, it is important to recognize that technology can 

provide the functionality to support workflow processes. But it is not a replacement for manage-

ment, merely a tool to aid management of workflow processes. The goal of workflow manage-

ment is to manage the flow of work such that the work is done at the right time by the proper 

person. Thus, there are four steps that must be completed before workflow management can oc-

cur. The first is to develop, define and document the tasks that make up a workflow group (set of 

tasks associated with the workflow set – documented in a procedures manual, paper and/or elec-

tronic). 

 

The second step is to create a comprehensive employee position outline that details the various 

duties and expectations of an employee. This type of outline provides a framework for training 

and evaluating an employee, based on specific criteria. With workflow management reports that 

relate the workflow procedures to the job outlines, management can then properly and objec-

tively evaluate employee performance, thus ensuring that for any given task or set of tasks, the 

highest levels of efficiency can be achieved. With such reporting, it is also possible to reduce 

management time demands in training and directly overseeing employees. It may also be possi-

ble to uncover inefficiencies in a particular task or set of tasks by revealing time discrepancies 

from one employee to another. 

 

With specific workflow groups of tasks defined, developed and systematized, it is also necessary 

to centralize task and workflow group assignment (Step three). With managers/partners overrid-

ing other managers/partners, employees can quickly become overwhelmed and discouraged by 

the lack of process controls. With process controls in place, employees can rely upon a depend-

able standard for workflow assignment. 

 

The final step is to integrate technology systems to increase efficiency by having management 

report generation and time studies made a part of the technology solution. With systems in place 

to record task completion, follow-up is a snap. Reports can be generated that uncover gaps in 

task completion, which focuses management on where the problem areas are. This saves time 

and builds greater efficiency into the overall process.  The result is a true workflow management 

system that might be illustrated as follows: 
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The 2007 Moss-Adams Compensation and Staffing Study of Advisory Firms concluded that, 

with fee compression issues, the only way to compete is by creating much larger firms, referred 

to in the study as ‘market dominators.’ With higher AUM figures to point to, it is felt that such 

firms possess greater negotiating strength with product vendors, etc. as well as economies of 

scale, which could potentially drive down internal operating costs. While this is potentially true, 

it is pre-mature to write off the smaller firms, particularly in light of workflow management tech-

niques that, if applied correctly, could result in substantial operational cost savings while poten-

tially increasing employee productivity and net revenue. 

 
David Lawrence, AIF®  (Accredited Investment Fi-
duciary™) is a practice efficiency consultant and is 
President of David Lawrence and Associates, a prac-
tice-consulting firm based in Lutz, Florida. 
(www.efficientpractice.com) David Lawrence is a 
much sought-after public speaker on a variety of lead-
ership, financial and technical topics. For details, visit 
www.davidlawrencespeaks.com. 
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Automatic replies for POP3 and IMAP accounts 

If your profile doesn't include an Exchange Server e-mail account, you can combine an Outlook e-
mail template with Outlook rules to reproduce the functionality of the Out of Office Assistant. By 
using this combination, you can use your POP3 or IMAP e-mail account to send automated re-
plies to incoming messages.  
 IMPORTANT   You must leave your computer on and Outlook running for the automated replies 
to be sent. 
Create a message template 
 
On the File menu, point to New, and then click Mail Message.  
On the Options tab, in the Format group, click Plain Text.  
In the message body, type the message that you want to send as your automated reply.  
In the message window, click the  

Microsoft Office Button and then click Save As.  
In the Save As dialog box, in the Save as type list, click Outlook Template (*.oft).  
In the File name box, type a name for your message template, and then click Save. 
Create a rule to automatically reply to new e-mail messages 
Do one of the following: 
On the Tools menu, click Rules and Alerts.  
In the Rules and Alerts dialog box, click New Rule.  
Under Start from a blank rule, click Check messages when they arrive, and then click 

Next.  
Under Which condition(s) do you want to check?, select the sent only to me check box 

and any other criteria that you want, and then click Next.  
When you see a dialog box informing you that this rule will be applied to every message that 

you receive, click Yes.  
Under What do you want to do with the message?, select the reply using a specific 

template check box.  
 
Under Step 2: Edit the rule description (click an underlined value), click a specific tem-

plate.  
 
In the Select a Reply Template dialog box, in the Look In box, click User Templates in 

File System.  
 
Select the template that you created in the previous section, and then click Open.  
 
Click Next.  
 
Optionally, select the check boxes for any exceptions to the auto-reply rule.  
 
Click Next.  
 
Under Step 1: Specify a name for this rule, type a name for the auto-reply rule, and then 

click Finish. 
 
The reply using a specific template rule in the Rules Wizard sends your automated reply only 
once to each sender during a single session. This rule prevents Outlook from sending repetitive 
replies to a single sender from whom you receive multiple messages. During a session, Outlook 
keeps track of the list of users to whom it has responded. If you exit Outlook and then restart it, 
however, the list of the senders who have received automated replies is reset. 
 IMPORTANT   For the Rules Wizard to send a reply automatically, Outlook must be running and 
configured to check periodically for new messages. 
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Your subscription gives you access to tons of other resources on the internet. Simply navi-
gate to: 
 

http://www.efficientpractice.com/newsletter to log in.  
 
From there, you have a world of choices available to you: 
 

1. Newsletter archive and database 
  

2. Other resources: 
topics from the world of operational efficiency: 
 

• Technology 

 

• Employee Resources 

 

• Procedures 

 

• Operational Tools 

 

• Efficiency publication library 

 

18313 Citation Street 

Lutz, Florida 33549 

Phone: 877-296-6876 

Fax: 813-649-8755 

E-mail: Info@efficientpractice.com 

The Efficient Practice 

Consulting and Resources for 

Financial Service and Business 

Professionals 

We assist our clients in realizing additional 

profits through a thorough analysis of your 

business operations from a variety of tactical 

perspectives that stress the efficient use of 

resources.  We have identified six critical 

factors of efficiency which form the basis of 

our evaluative process. We do this by taking 

the time to learn everything we can about 

your business and then offer recommendations 

based on where you want to take it. And we 

offer on-going support and coaching to ensure 

that your path to increased profit continues 

unabated.  

Access a wealth of resources: 

We’re on the web! 

www.efficientpractice.comwww.efficientpractice.comwww.efficientpractice.comwww.efficientpractice.com    

Questions or comments? 
 

Email: 
info@efficientpractice.com 

David L. Lawrence, President 


